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Apple quietly updates white
MacBook with unibody specs

$999
by Thomas Ricker

Engadget - Jan. 21,2009

Hmmm, what’s this? Did Apple just up-
date its lowly, $999 white plastic polycar-
bonate MacBook to more closely align
with its new unibody MacBooks? Why
yes, yes it has... sometime in the last 3
days according to Google’s cache. So for
the same $999 you now get that newer
generation 2.0GHz Core 2 Duo proces-
sor with faster 1,0660MHz frontside bus,
2GB of 667MHz DDR2 SDRAM memo-
ry standard (up from 1GB), and integrat-
ed NVIDIA GeForce 9400M graphics.
Whitey is still stuck with DDR2 SDRAM
though, not the speedier DDR3 found in
the unibodies. Disk drive and other specs
(including Firewire 400) appear to be the
same. Getting ready for Snow Leopard’s
OpenCL GPU support are we Apple?

Update: Bluetooth received a bump
from 2.0 to 2.1 as well.

Anything else? @

Mark Papermaster to Begin
at Apple as Senior Vice Presi-
dent of Devices Hardware
Engineering on April 24

Apple® announced that Mark Papermas-
ter will be coming to Apple as senior vice
president of Devices Hardware Engineer-
ing, reporting to Apple CEO Steve Jobs,
on April 24. Papermaster, who comes to
Apple from IBM, will lead Apple’s iPod®
and iPhone™ hardware engineering
teams. The litigation between IBM and
Mark Papermaster has been resolved.

Papermaster has 25 years of product
and technology experience, and was
previously a vice president at IBM. He
has a Bachelor of Science degree in
Electrical Engineering from the Uni-
versity of Texas, and a Master of Sci-
ence in Electrical Engineering from
the University of Vermont in 1988. Pa-
permaster is active with the University
of Texas where he is a member of the
Electrical and Computer Engineering
Advisory Council. &

MAC TIP:
Protect the Path of
Least Resistance

A lightning strike can travel through
phone lines or Ethernet cables as well
as electrical lines. If your Mac has such
cables attached, use a surge protec-
tor with the necessary jacks to protect
your equipment from these additional
sources of potential damage. @

& BAC February Meeting &

The February 14th meeting of the
Birminigham Apple Core will begin at
10:00am and the topic will be Picasa 3
for Mac (beta) a free download from
Google to find, edit and share your
photos with iPhoto integration present-
ed by Mr. Oto Ekres. Arrive early and
enjoy coffee, doughnuts and enlighten-
ing discussions.


http://www.applecore.org
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For Sale/Wanted
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Do you have computer related
items for sale or is there an item
that you would like topurchase?
We will list the item in this space

ree of charge to current BAC

members.

Send information by the 25th

of each month to the editor at:
henryw @bellsouth.net.

Treasurer still needed for
Board of Directors

BAC PROGRAMS
NEEDED

The BAC is constantly in need of pro-
gram ideas and speakers. A few of our
planned topics for the coming year are:

- Presentations with Keynote

- iPhone development

- Cool stuff with Numbers

- Toast

If you have any ideas or contacts with

potential presenters please let the board
know.

Don’t forget our new training CDs
for Leopard MAC OS X 10.5.

Also we still have the OS X 10.4 “Ti-

ger” training CDs available as well.

Contact Luther Fuller for more infor-
mation or go to our website. @

Apple Posts Nvidia Update
and quickly pulls it.

Obiously there was something not
quite right and would expect to see this
reposted soon.

About
2009

This update improves cursor move-
ment when using the Apple Mini Dis-
playPort to Dual-Link DVI adapter with
the Mini DisplayPort enabled MacBook
Air, MacBook and MacBook Pro.

It also improves playback of HD vid-
eo running on systems with NVIDIA
GeForce 7300 GT or GeForce 9600M
graphics. @

NVIDIA Graphics Update

iPhone and iPod Touch
Update Available

Apple released iPhone Software ver-
sion 2.2.1, a maintenance and stability
release that improves performance in
mobile Safari and corrects issues with
photos saved from Mail.

For iPhone

More specifically, Apple said the
246 4AMB update:

* Improves the general stabil-
ity of Safari.

* Fixes an issue where some
images saved from Mail do not dis-
play correctly in the Camera Roll.

For iPod touch

A similar version of the software up-
date available to iPod touch owners in-
cludes both of the aforementioned im-
provements in addition to correcting
an issue that caused some Apple Loss-
less (ALAC) to skip during playback.
iPhone Software 2.2.1 is compatible
with the iPhone 3G and the original
iPhone, while iPhone Software 2.2.1
for iPod touch is compatible with both
the first and generation of the touch-
screen media player. @

iMovie HD 6

Previously available as a free down-
load for iLife ‘08 users, has been re-
moved from Apple’s site.

The application, which had been
part of the iLife ‘06 suite, was made
available amidst public outcry after
a complete rewrite of the application
as iMovie ‘08 resulted in the loss of
a number of features that users had
come to rely on. iMovie HD 6 was
available through Apple’s site to us-
ers with a valid iLife ‘08 installation
for nearly a year and a half, but has
disappeared in a move presumably re-
lated to the arrival of iLife ‘09. The
new iLife suite includes iMovie ‘09,
a significant update to the much-criti-
cized iMovie ‘08. The download was
available as a direct download for a
short while but this has been pulled by
Apple as well. &
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Apple Reports First Quarter Results
Best Quarterly Revenue and Earnings in
Apple History iPod Sales Set New Record

Apple® announced financial results for its fiscal 2009 first
quarter ended December 27, 2008. The Company posted re-
cord revenue of $10.17 billion and record net quarterly profit
of $1.61 billion, or $1.78 per diluted share. These results
compare to revenue of $9.6 billion and net quarterly profit
of $1.58 billion, or $1.76 per diluted share, in the year-ago
quarter. Gross margin was 34.7 percent, equal to the year-ago
quarter. International sales accounted for 46 percent of the
quarter’s revenue.

In accordance with the subscription accounting treatment
required by GAAP, the Company recognizes revenue and
cost of goods sold for iPhone™ and Apple TV® over their
economic lives. Adjusting GAAP sales and product costs to
eliminate the impact of subscription accounting, the corre-
sponding non-GAAP measures* for the quarter are $11.8 bil-
lion of “Adjusted Sales” and $2.3 billion of “Adjusted Net
Income.”

Apple sold 2,524,000 Macintosh® computers during the
quarter, representing nine percent unit growth over the year-
ago quarter. The Company sold a record 22,727,000 iPods
during the quarter, representing three percent unit growth
over the year-ago quarter. Quarterly iPhone units sold were
4,363,000, representing 88 percent unit growth over the year-
ago quarter.

“Even in these economically challenging times, we are
incredibly pleased to report our best quarterly revenue and
earnings in Apple history —surpassing $10 billion in quar-
terly revenue for the first time ever,” said Steve Jobs, Apple’s
CEO.

“Our outstanding results generated over $3.6 billion in
cash during the quarter,” said Peter Oppenheimer, Apple’s
CFO. “Looking ahead to the second fiscal quarter of 2009,
we expect revenue in the range of about $7.6 billion to $8
billion and we expect diluted earnings per share in the range
of about $.90 to $1.00.” &
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Sleeep...

If you’re using Leopard there’s a new hidden method that’s
easier to use than all the others and requires no use of the
mouse or menus. Just press Shift/Control/Eject and all at-
tached displays will instantly go to sleep. Move your mouse
or press a key on the keyboard, and the displays awaken.

It doesn’t get much simpler than that. Note that if you’ve
set your system to require a password whenever your com-
puter wakes up from sleep or from your screen saver, that
password prompt won’t be triggered if you put your displays
to sleep this way. You can still make it happen, though, by
first activating your screen saver and then pressing Shift/
Control/Eject. The password dialog box will appear when
you press the hot-key combination, but if you then click on
“Cancel,” the displays should go to sleep.

~ Rob Griffiths
Macworld Magazine

QuickLook Tricks

QuickLook is a great new Leopard feature that enables you
to see the contents of many documents without having to
open them in the normal way. Simply click the document
icon in the Finder to highlight it, then press the Space bar
and the document opens in a preview window.

When this happens, don’t miss the possibility that other
functions are offered. Most QuickLook windows can be en-
larged to full screen view; images can be saved direct to your
iPhoto library; multipage PDFs can be scrolled through; and
in many cases you can zoom into and out of the preview im-
age by holding down the Command and Option keys while
clicking the mouse button.

Notice too that once you have a QuickLook preview win-
dow open, you can view the remaining items in the same
folder simply by using the right and left (or up and down)
arrow keys.

Not all documents will be displayed and some may not be

displayed completely accurately — this function needs the
application programmer’s help to work well.

I recently became aware that the QuickLook function can
be extended with the use of plugins, and am using two of
these successfully. Rather than showing just a folder icon
when QuickLook is applied to a folder, the “Folder Quick-
Look Plug-in” shows the contents of the folder in an infor-
mative list view. Similarly, the “Zip QuickLook Plug-in”
shows the contents of a Zip archive without needing to open
it in the normal way. These two plug-ins can be found at
<homepage.mac.com/xdd/>. cont’d on page 4
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HINTS & TIPS cont’d from page 3

No doubt others will follow.
AUSOM News, Melbourne, Australia

Reduce PDF Sizes

The Portable Document Format (PDF) has become a very
popular means for sharing files, particularly between Mac
and PC users. One down side to the PDF format, however,
is they often swell to large files becoming unwieldy for in-
ternet traffic.

Provided you are not after a super high-quality PDF, a re-
ally easy way to reduce the size of these files is tucked away
in the printing options for each document. For best results,

try this on an original document (ie.not a PDF).

Open the file you wish to convert to PDF and select File >
Print. Change “Copies and Pages” to “ColorSync.” Change
the Quartz Filter option to “Reduce file size.”

Click on the PDF button and choose “Save as PDF” to
create your reduced file.

Editor’s Note: The above Tip works if you are using Tiger
(and if, like me, you have not lost the Reduce File Size
Quartz Filter!!!).

In Leopard I believe you need to follow through to the
Print dialog box but from that click Preview and when
your document is open in the application Preview select
File Save As ... Select PDF as the format and you will see
Quartz filters available to you.

~ Ivan Radywonik
AUSOM News, Melbourne, Australia

Send iCal Invites to the Many

Q: Can Apple’s iCal let me email an event invitation to
multiple users?

A: It wouldn’t be much of a calendar program if it couldn’t!
In Leopard’s version of iCal, click on the event and press
Command/E to edit it. Click on “Add Attendees” and type
the name of a person you’d like to invite. If you’ve entered
that person’s email address in Address Book, iCal will put
the address in for you. If not, just type the address. To add
another address, type a comma and enter the new name (if

he or she is in Address Book) or the address. Repeat as
necessary. When you’ve finished entering addresses, press
Return and then click on “Send.” Mail will launch and send
an event invitation to the addresses in the Attendees field.

Alternatively, you can add multiple attendees by dragging
individual contacts or an entire group directly from Address
Book onto the “Add Attendees” link.

This method is very efficient when you want to quickly
add all the members of your platoon, bridge club, or ex-
tended family.

~ Christopher Breen
Macworld Magazine

Beware of Memorex
Recently I needed to reuse an archived document that
I had backed up onto a Memorex CD-R just 4 years ago.
When I put it into my CD tray, nothing showed up on my
desktop. I tried another computer — same thing. I tried two
external CD-R devices — same thing. I tried several other
CDs burned at the same time containing other files —
none were readable, although they were readable immedi-
ately after burning, because I added their contents to my
CD Finder database soon after burning. When I contacted
Memorex via its website, all I got was boilerplate messages
that did not address my problem. I could not find any phone
number for tech support of its site. All of my archived files
are now lost forever. Whatever happened to the promise
that CDs would last 50-100 years? This reminded me of
when I purchased several Memorex VHS tapes and sent in
its coupon for a $3 rebate. All I received from them was a
letter stating that I didn’t complete the rebate form correct-
ly. I will NEVER purchase anything again from Memorex.
I suggest you do the same!
Paul Taylor, Editor

Archival DVDs

Verbatim’s newly released Ultra Life Gold Archival Grade
DVD-R media is the most durable, longest-lasting DVD-R

media you can buy. These discs have two features de-
signed to increase their useful life: a gold layer that covers
the silver recording layer, and an extra-hard coating to pro-
tect the discs from scratches.

The gold layer is claimed to reduce the possibility of cor-
rosion of the silver layer, which (aside from scratches) is
the primary cause of disc failure.

We suggest that if you’re archiving important files onto
DVDs, consider using these discs. Street price is $10 for
five DVD-R discs, or $80 for 50 discs. Verbatim also has an
UltraLife Gold CD-R, available for as little as $50 for 50.
(Prices are from www.mediasupply.com)

www.verbatim.com

via Design Tools Monthly

A Unique Hard Drive “Enclosure”

There are a number of USB-to-SATA adapters that let you
connect a bare SATA drive to a USB port on your computer.
They re useful for quickly copying a lot of data, or for clon-
ing a hard drive before installing it into a computer.

But now NewerTech has made one that goes beyond all
that, by not only including USB, FireWire 400, FireWire
800 and eSATA interfaces, but using a form factor that lets
you simply drop the bare drive edge-first into a desktop
block, much as if it were a cartridge. No cables or plugs to
attach to the drive - just slide it in.

The fanless, silent Voyager costs $100 and supports both
2.5” (laptop) and 3.5” (desktop) hard drives, with a push
button to eject the bare drive. cont’d on page 5
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HINTS & TIPS cont’d from page 4

Because of its flexibility and ease of operation, we suggest
considering it as a base unit to host a rotating set of backup
hard drives, or for photographers and others who back up
projects onto hard drives. It’s more cost-effective than buy-
ing several external enclosures, and the bare hard drives are
smaller to store. You can learn more and get these at <www.
newertech.com> and <macsales.com>.

Design Tools Monthly

Important Passwords

Those of us who work on other folks’ Macs are used to find-
ing that they have no idea what important passwords are in
effect on their systems, necessitating a more or less complex
and time-consuming process to make things accessible.

Here are the key passwords that you should know and write
down somewhere.

Login password.

If you go to the Apple menu and choose Log Out [your ac-
count name] you will after a little while see a Login screen.
Click your name and you’ll be asked for a password. Do you
know what it is? You should, but the good news is that it can
be reset by your friendly Mac service bod.

This is also the Administrator’s password that enables you
to install new applications and make other alterations to your
system’s functions. It really is important. Keychain pass-
word. This is normally the same as your Login password,
but may not be so if your Login password has been reset.

Go to Applications/Utilities/ Keychain Access and open that
program. From the View menu choose “Show Keychains.”

Select any keychain shown to be locked, and from the File
menu choose Unlock Keychain. If you can’t provide the cor-
rect password you can’t access the items in that keychain,
in which case all you can do is use the File menu to delete
the keychain and set up a new (empty) one with the same
name.

Use your Login password as the keychain password.

ISP login password. This was initially given you by your
Internet Service Provider but may have been changed sub-
sequently. It enables you to establish an Internet connection
via a modem or router, where the password is held. If you
need to know this and don’t, resolving the situation usually
involves contacting your ISP and then revising settings in
your router and/or your Mac. You can save a lot of service
time if you know what this password is. Email password.
Your email account (and each of them if you have more than
one) has a password that enables you to collect mail sent to
that address. For most folks this will be the same as the ISP
login password, but if you have more than one mail account
(address) it may well not be. Again, you can save a lot of
angst by ensuring that you know the password for each of

your email accounts (addresses).

Airport network password. If your wireless network has
been properly set up, it requires that anyone wishing to use it
must be able to supply the correct password.

Your own Mac will have learned and remembered the pass-
word and it’s not too hard to find out what it is.

Open Keychain Access once again, Show Keychains, and
examine the “login” and/or “account name” keychains for
an item of Kind: “Airport network password” with the name
of your network in the Name column. Double-click that item
and in the window that opens, tick the Show Password box.
Provide the keychain password (see above) and you’ll be
shown the Airport network password.

Airport Base Station password.

This password is required for you to alter settings in your
base station. To find out what it is (for Apple products only),
follow the procedure in the paragraph above, but this time
look for an item of Kind: “Airport base station password,”
with the name of your base station in the Name column.

If you have a third party wireless router such as a Netcomm
or Netgear, and don’t know what its password is, try “ad-
min” or “password” or no password.

If these fail, you’ll need to reset the router and reconfigure
it with a new password.

File Vault password.

If you have File Vault turned on (System Preferences > Se-
curity > File Vault), there is a password required to decrypt
its contents, which is your Login password. If you are an Ad-
ministrator on your Mac, there is also a Master password.

If something nasty happens with regard to your Login pass-
word, and you don’t know the Master, your files are gone
forever (no kidding!).

Before it’s too late, for goodness” sake turn File Vault off,
unless you are really knowledgeable about its operation, and
have all your documents backed up (unencrypted) elsewhere
at all times.

AUSOM News, Melbourne, Australia
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PERRY «

Computer Services
e Consultation * Sales Authorized
* Installation * Training Zﬁg‘; 33;1‘:1[}:::?;3::
* Digital Imaging Solutions
Chris Perry
1722-B 28th Ave. So., Homewood, AL 35209
Phone (205) 870-7044 Fax (205)780-1944

e-mail: chri com
WWw.perrycomputer.co

PERRY COMPUTER SPECIALS OF THE MONTH

MACBOOK 13IN 24GHZ C2D/2G/160GB/SD/WHITE Normal price $1299.00 now $1050.00
Leica Camera C-Lux3  $100.00 Rebate ends February 31, 2009

Leica Camera D-Lux4  $150.00 Rebate ends February 31, 2009

Leica Camera M8 $1500.00 Rebate ends February 31, 2009

Leica Lens For M8 Some have a $300.00 rebate ends February 31, 2009

Some iPods are on sale.

Also, Meade telescopes are in stock.

BAC

BIRMINGHAM APPLE CORE

MACINTOSH USER GROUP
Bill Henry, Editor

2438 Mahaska Drive
Birmingham, AL 35244

Aftend the Bac
Monthly Me Etl[lg

Be sure to check your mailing label for your BAC renewal month.
To renew, mail $30 to BAC, 3417 Wisteria Drive, Birmingham, AL


www.perrycomputer.com

